
1 Touchpad iPRIME (Version 1.0)-VI  (Answer Key)

 �Categories of Computers and  
Computer Languages

OneOne LearnTouch

A.	 1.	 a.	 2.	 b.	 3.	 d.	 4.	 c.	 5.	 a.
B.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 T
C.	 1.	 Microcomputer		  2.	 laptop	 3.	 instructions
	 4.	 programming			   5.	 assembler

ItLet's Do

A.	 1.	 Minicomputer is small general-purpose computer having the capability to serve a number 
of users simultaneously.

	 2.		 An embedded computer is a special type of microprocessor based system that is developed 
for performing a specific task.

	 3.	 C and BASIC are the types of 3GL.
	 4.	 An assembler is a program used to translate assembly language into machine language.
	 5.		 A computer language is the means by which instructions and data are transmitted to the 

computer.
B.	 1.	 A hand held computer is a type of computer that can easily be stored in our pocket and 

used by holding it in our hands. The name of two handheld computers are:
	 a.	 Smartphones
	 b.	 Smart watches
	 2.		 Digital computers are computers that use binary numbers (0 & 1) to generate, process and 

display data. Examples – Desktop, Laptop.
	 3.		  HLL						      LLL
	 a.	 Machine independent	 a.	 Machine dependent
	 b.	 Easy to understand	 b.	 Difficult to understand
	 c.	 Coding contains English words	 c.	� Coding is in the form of 0 and 1 

or ‘Mnemonics’
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	 d.	 Example: C, C++	 d.	� Example: Machine language, 
Assembly language

	 4.		 High-level language is user friendly.
		  In High-level language it requires less time to write a program.
		  High-level language is easier to maintain.
		  High-level language is problem oriented rather than ‘Machine Based‘.
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 �File Management—Organisation of Data

OneOne LearnTouch

A.	 1.	 b.	 2.	 c.	 3.	 c.	 4.	 a.	 5.	 a.

B.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 T

C.	 1.	 File format	 2.	 sorting 	 3.	 .pptx	 4.	 Partitions 	 5.	 asterisk 

D.	 1.	 d.	 2.	 c.	 3.	 e.	 4.	 a.	 5.	 b.

ItLet's Do

A.	 1.	 Data is arranged in a computer by type, by size, by name and by date of creation and 
modification.

	 2.	 Sorting is used to arrange the files in a computer.
	 3.	 docx and .pptx are examples of file extension.
	 4.	 Asterisk(*) and question mark(?) are the types of wildcard characters.
	 5.	 Show windows side by side option is used to open multiple applications in windows.
B.	 1.	 Asterisk represents a string of characters while searching whereas question mark represents 

a single character while searching.
	 2.	 Windows Explorer is the file manager used by Windows 95 and later versions. It allows users 

to manage files, folders and network connections as well as search for files and related 
components. 

	 3.	 The steps to sort the files as per Size are as follows:
		  Step 1	 Right-click on the blank space in the Windows Explorer window. A shortcut menu 

will appear.
		  Step 2	 Select the Sort by Size option.
	 4.	 When we work on a computer, we might need to work on more than one files at a time 

or open more than one application at a time. For example, while working in a Word file, 
we would be using Google for searching and PowerPoint for making presentation. If we 
need some images for the presentation, we would have the image folder open in Windows 
Explorer as well. 

	 5.	 We use wildcard for searching when we don’t know the location and complete name of 
the file.

Crack CodeThe

A.	 1.		 He should use cut command instead of copy command. 
	 2.	 By checking the file extension of both the files. The presentation will have .pptx extension 

and Word will name .docx.

2.
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Do yourself.

 �Word Processor—Tabular Representation

OneOne LearnTouch

A.	 1.	 b.	 2.	 b.	 3.	 c.	 4.	 a.	 5.	 a.
B.	 1.	 Resizing  	 2.	 Merging  	 3.	 Layout  	 4.	 Design  	 5.	 Delete Rows 
C.	 1.	 F 	 2.	 T	 3.	 T	 4.	 F	 5.	 F

ItLet's Do

A.	 1.	 The intersection of a row and a column in a table is called a cell. 
	 2.	 Table Styles is a feature with which a user can format the entire table quickly.
	 3.	 Shading is an option to apply colors to cell or group of cells in a table.
B.	 1.	 To add a row in a table, follow these steps:
		  Step 1	 Select the row of the table where you want to add another row.
		  Step 2	 Click on the Layout tab.
		  Step 3	 Choose Insert Above or Insert Below commands.

3.
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	 2.		 To insert a table, follow these steps:
		  Step 1	 Click on the Insert tab.
		  Step 2	 Click on the Table command in the Tables group.
		  Step 3	 Click on the Insert Table option. 
		  Step 4	 Enter the required number of columns and rows you want to insert.
		  Step 5	 Click on OK button. The table will be inserted.
	 3.	 To merge two cells, follow these steps:
		  Step 1	 Select the cells to be merged.
		  Step 2	 Click on the Layout tab.
	 	 Step 3	 Click on the Merge Cells command. 
		  The selected cells are merged as one cell.
	 4.	 Splitting cells in a table is dividing one cell into two or more cells whereas Merging  

cells in a table is combining two or more cells in the same row or same column into a 
single cell.

Crack CodeThe

A.	 1.	 Insert above			   2.	 Insert below			   3.	 Delete
	 4.	 Merge cells			   5.	 Split cells
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Do yourself.

 Word Processor—Mail Merge

OneOne LearnTouch

A.	 1.	 a.	 2.	 b.	 3.	 b.
	 4.	 c.	 5.	 a.	 6.	 a.
B.	 1.	 T	 2.	 F	 3.	 F	 4.	 T
C.	 1.	 Mail merge			   2.	 Main document
	 3.	 Mailings			   4.	 Write and insert fields

ItLet's Do

A.	 1.	 Data source is a separate file that contains all information about recipients of the letter.

	 2.	 The name of the command used to add addresses list is Type New List.

	 3.	 Preview Results command is used to see the preview of the merged letters.

B.	 1.	 Four advantages of Mail Merge are:
	 (i)	 It saves time and efforts.
	 (ii)	 It allows to make changes in several letters very quickly.
	 (iii)	It allows to produce thousands of letters quickly.
	 (iv)	It allows to save the letters as template for later use.

	 2.	 There are three main components of Mail Merge in MS Word which are as follows:
	 (i)	� Main Document: It is a document that contains the text of the letter which we want to 

send to our friends.
	 (ii)	� Data Source: It is a separate file that contains all information about recipients of the 

letter 
	 (ii)	� Merged Document: It is the final document created by merging the Main Document 

and Data Source. It contains a list of letters with text and detail of a person.
	 3.	 Merged Document is the final document created by merging the Main Document and Data 

Source. It contains a list of letters with text and detail of a person.

Crack CodeThe

A.	 Mail merge feature

4.
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Do yourself.

 Presentation—Visual Effects

OneOne LearnTouch

A.	 1.	 b.	 2.	 a.	 3.	 b.	 4.	 c. 
B.	 1.	 F	 2.	 F	 3.	 F	 4.	 T
C.	 1.	 Insert video 	 2.	 slide  	 3.	 text 	 4.	 object

ItLet's Do

A.	 1.	 Slide Show view allows to view the presentation in full screen mode.
	 2.	 Transition determines how your presentation moves from one slide to the next. 
	 3.	 Slide transition determines how presentation moves from one slide to next whereas 

Animation is the addition of special  visual/sound effects to the text and graphics in a 
slide.

B.	 1.	 To insert sound to a presentation, follow these steps:
	 	 Step 1	 Click on Audio command on the Insert tab.
		  Step 2	 Select the Audio from file option.
		  Step 3	 Navigate and select the audio file to be inserted and click on Insert button. 

5.
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		  Step 4	 Click on Play button to listen the audio.
	 2.	 Action button is used to move from one slide to another and play media files. There are 

12 different types of action buttons are available in PowerPoint.
	 3.	 Four views in PowerPoint are:
	 a.	 Slide Sorter View
	 b.	 Notes Page View
	 c.	 Reading View 
	 d.	 Slide Show View

Crack CodeThe

A.	 1.	 Action button
	 2.	 Animation 
B.	
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Worksheet-1
(Based on chapters 1 to 5)

A.	 1.	 Desktop		  Laptop
	 2.	 PDP-11		  PDP-8
	 3.	 ATM		  Microwave
	 4.	 Smartphone		  Smart watch
B.	 1.	 The process of writing a program is called programming.
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	 2.	 Wildcard is a special character which is used to represent one or more characters.
	 3.	 A file extension is a group of two or more characters used to identify the type of a file.
	 4.	 Splitting refers to dividing one cell into two or more cells.
	 5.	� The Mail Merge feature in MS Word is used to create personalised letters to be sent to 

many people.
	 6.	 Notes pane is the area where a speaker can write notes for himself.

C.	 1.	 Tables		  Insert
	 2.	 Cell size		  Layout
	 3.	 Cell size		  Layout
	 4.	 Merge		  Layout
	 5.	 Table styles		  Design

D.	 1.	 Hybrid
	 2.	 Natural Languages
	 3.	 Assembler
	 4.	 Right-click
	 5.	 Table Resize Handle
	 6.	 Data Source
	 7.	 Animation
	 8.	 Slide Sorter View

Test Sheet–1
(Based on chapters 1 to 5)

Section A
A.	 1.	 c.	 2.	 d.	 3.	 c.	 4.	 a.
	 5.	 d.	 6.	 a.	 7.	 b.	 8.	 d.
B.	 1.	 Minicomputer	 2.	 Microcomputer	 3.	 fifth
	 4.	 MP4	 5.	 Borders and shading	 6.	 Mailings
C.	 1.	 T	 2.	 T	 3.	 T	 4.	 T	 5.	 T

Section B
A.	 1.	 A smart watch is a computing device which you can wear on your wrist. It provides the 

features of an older watch and some advanced features of smartphone like connecting to 
the internet, using mobile apps, and making phone calls, etc.

	 2.	 Supercomputer
	 3.	 Table is very useful in enhancing and analyzing the data. 
	 4.	 Merged Document is the final document created by merging the Main Document and Data 

Source.
	 5.	 The Notes Page view shows user how notes pages look like in printed form. In this view, 

slide of our presentation and the speaker notes that we have added within the Notes pane 
for each individual slide appear together.
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B.	 1.	 A low-level language is a programming languages that is machine dependent. A program 
written in machine dependent language runs only on one particular type of computer. 

	 Two low-level languages are: Machine Language and Assembly Language.  
	 2.	 A file extension is a group of two or more characters used to identify the type of a file. Two 

examples are: JPEG and MP4.
	 3.	 A table is an arrangement of text in form of columns and rows.
		  Steps to apply a table style:
		  Step 1	 Click anywhere on the table. The Design tab appears on the ribbon.
		  Step 2	� Click and select the design of your choice from the Table Styles group. The 

selected style will be applied to the table.

	 4.	 Three advantages of Mail Merge are:
	 (i)	 It saves time and efforts.
	 (ii)	 It allows to make changes in several letters very quickly.
	 (iii)	It allows to produce thousands of letters quickly.

	 5.	 Yes, Object command.

 Scratch Programming—Game Creation

OneOne LearnTouch

A.	 1.	 c.	 2.	 a.	 3.	 c.	 4.	 a.	  5.	 a.

B.	 1.	 F	 2.	 F	 3.	 F	 4.	 T	 5.	 T

C.	 1.	 Pen	 2.	 regular	 3.	 Stamp	 4.	 Sound	 5.	 Operators

D.	 1.	 Control block			   2.	 Looks block

	 3.	 Motion block			   4.	 Events block

ItLet's Do

A.	 1.	 Pen blocks in Scratch allow a Sprite to draw shapes and plot coloured pixels on the 
screen.

	 2.	 The components of scratch window are Sprite, Stage, Blocks palette and Scripts area.

	 3.	 Block palette contains various predefined blocks that are used to perform specific tasks. 
These blocks are used to create scripts in Scratch.

	 4.	 Repeat block is used to draw a pentagon.

	 5.	 Name of two conditional control blocks are Forever and Forever–if.

6.
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B.	 1.	 The four methods to choose a sprite are:
	 a.	 Paint a new sprite
	 b.	 Choose a sprite from the library
	 c.	 Upload a sprite from file
	 d.	 A new sprite from the camera. 
	 2.	 Blocks are puzzle piece shapes that are used to give instructions to the computer.
		  Name of two conditional blocks are control block and Event block.

Crack CodeThe
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 HTML—An Introduction

OneOne LearnTouch

A.	 1.	 a.	 2.	 c.	 3.	 c.	 4.	 d.	 5.	 b.
B.	 1.	 F	 2.	 F	 3.	 T	 4.	 T	 5.	 T
C.	 1.	 markup 	 2.	 <head> 	 3.	 <b> 	 4.	 <p>	 5.	 <sub>

ItLet's Do

A.	 1.	 HTML is a markup language that describes the structure of the web page.
	 2.		 The tags that have both opening and closing tags are called Container Tags.
	 3.	 (i)	 A web page is a document that contains text, graphics, videos, audios and links to 

other pages.
	 (ii)	 A website is a collection of web pages.

7.
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B.	 1.	 The <HTML> tag tells the web browser that the text contained between <HTML> and  
</HTML> is a web page and can be viewed using a web browser. Every web page coding 
must starts with the <HTML> tag and ends with the </HTML> tag.

		  The <BODY> tag tells the web browser that the text contained between <BODY> and  
</BODY> tags is to be shown on the web page. It is a container tag.

	 2.		 Rules for writing HTML codes: 
	 (i)	 Values given to the attributes should be enclosed within the double quotes.
	 (ii)	 Tag name should not contain spaces.
	 (iii)	 There should be no spaces between < and > in a tag.
	 (iv)	 Tags must be nested correctly. 
	 3.	 <BR> tag <HR> tag

a. �<BR> tag means Line Break tag. a. �<HR> tag means horizontal ruler tag.

b. �<BR> tag is used when user want to 
start divide new line.

b. �<HR> tag is used when user want to web 
page into different sections.

Crack CodeThe

A.	 1.	 <HR>	 2.	 <u>	 3.	 <BR>
	 4.	 <HTML>	 5.	 <BODY>	 6.	 <H1>
B.	
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 Internet Services and Cyber Security

OneOne LearnTouch

A.	 1.	 d.	 2.	 a.	 3.	 c.	 4.	 d.	 5.	 a.
B.	 1.	 T	 2.	 F	 3.	 F	 4.	 T	 5.	 T
C.	 1.	 Carding	 2.	 E-greeting	 3.	 Chat	 4.	 cyber security 

ItLet's Do

A.	 1.	 Phreaking crime is committed against telephone companies by using computers with the 
goal of making free distance calls, impersonating directory assistance or other operator 
services, diverting calls to numbers of the perpetrator’s choice, or tapping phone lines.

	 2.	 Newsgroup is the title given to a discussion group. A newsgroup focuses on a particular topic. 
	 3.	 Use of social networking services is not advisable for students because these services are 

generally considered as a source of distraction from education for students.
	 4.	 Hacking is the practice of modifying computer hardware and software to accomplish a goal 

outside of the creator’s original purpose.
	 5.	 A cloud storage is a service where the users are able to store and manage data on remote 

server in place of their local computer.
B.	 1.	 Four Safety measure while using Internet are:
	 (i)	� Never provide personal information, such as address, phone number, or school name 

or location.
	 (ii)	 Keep your browser’s privacy settings ON.
	 (iii)	Use the Internet only in the presence of your elders.
	 (vi)	Do not share passwords (other than your parents or teachers).

	 2.	 Different types of Communication techniques are:
	 (i) �E-mail 

E-mail stands for electronic mail. You can send messages and files from your 
computer to your friend’s computer and vice-versa using e-mail service. It is fast 
and generally delivered within few seconds (depending on the network speed) after 
sending. 

	 (ii) �Video Conferencing 
You use telephones and mobiles to talk to your friends and relatives. With the 
advancement in technology, you can now see the person with whom you are 
talking. The technique of watching the person while talking to him is called video 
conferencing. In video conferencing, there can be two or more persons at different 
locations simultaneously talking to each other by both audio as well as video.

	 (iii) �Voice-over-Internet Protocol (VoIP) 
	Voice-over-Internet Protocol (VoIP) is a technology which gives calling facility over 
the Internet. It is basically used for voice communications.

8.
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	 3.	 Computer hacking is the practice of modifying computer hardware and software to 
accomplish a goal outside of the creator’s original purpose. On other hand, cracking is the 
process of stealing personal information, changing financial data, breaking security systems 
and gain unauthorised access of computer systems.

	 4.	 There are various types of cyber threats are as follows:
		  Data Diddling: Refers to the process of changing the data going into or out of a computer. 
		  Phreaking: This crime is committed against telephone companies by using computers 

with the goal of making free distance calls, or tapping phone lines.
		  Cloning: This refers to a fraud in which scanners are used to steal the electronic serial numbers 

of cellular phones, which may used for billing purposes and making broadcast calls. 
		  Carding: This refers to the process of stealing credit card numbers online, to be resold or 

used to charge merchandise against victim’s account.
		  Hacking and Cracking: Computer hacking is the practice of modifying computer hardware 

and software to accomplish a goal outside of the creator’s original purpose. 
		  Cracking: The process or stealing personal information, changing financial data, breaking 

security systems to gain unauthorized access of computer systems is called cracking. 

Crack CodeThe

A.	 1.	 E- banking			   2.	 No, this is a wrong way.
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Do yourself.

 E-mail an Introduction

OneOne LearnTouch

A.	 1.	 c.	 2.	 a.	 3.	 d.	 4.	 b.	 5.	 c.	 6.	 c.

B.	 1.	 F	 2.	 F	 3.	 F	 4.	 T	 5.	 T	 6.	 F

C.	 1.	 Bcc 	 2.	 To  	 3.	 Cc	 4.	 Attachment	 5.	 Sent  

ItLet's Do

A.	 1.	 Internet is a computer network that connects hosts and end systems throughout the world.
	 2.	 We use emoticons to represent facial expressions.
	 3.	 Yes, we can send a video file as attachment in an e-mail.
	 4.	 An electronic mail or e-mail cab be defined as the process of exchanging messages 

electronically through a communications network by clicking on it.
B.	 1.	 Signing in is the process to open a session with an account that is already created. To sign 

in, double-click on web browser icon  click on sign in button  Enter user name and 
password   click on Next button

	 2.		 E-mail has various advantages, some of them are:
	 (i)	 An e-mail can be sent anytime and from anywhere in the world.
	 (ii)	 An e-mail can be sent to many people at a time.
	 (iii)	An e-mail can be easily forwarded to anyone without typing it again.
	 (iv)	Sending an e-mail is fast in comparison to traditional mails.
	 3.	 E-mail has several features. Some of them are as follows:
	 (i)	 Ability to attach the files along the message.
	 (ii)	 Ability to store the information such as message and contact list.
	 (iii)	Ability to send Multipurpose Internet Mail Extensions (MIME) type files.

Crack CodeThe

A.	 1.	 He can send music file by using attachment.

	 2.	 Ajay’s e-mail id in ‘to’ field and others e-mail address in ‘BCC’ section.

9.
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	 3.	 He should log out of his e-mail account.
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 More on Internet

OneOne LearnTouch

A.	 1.	 a.	 2.	 a.	 3.	 b.

	 4.	 d.	 5.	 a.

B.	 1.	 blog	 2.	 blogger	 3.	 online

	 4.	 cash on delivery		  5.	 drive

C.	 1.	 F	 2.	 T	 3.	 T
	 4	 F	 5.	 T

ItLet's Do

A.	 1.	 Google Docs option is used to create word file on Google Drive.

	 2.	 Name of two modes of payments are Net Banking and E-Wallet.

	 3.	 OTP stands for one time password.

	 4.	 Two e-commerce websites are www.amazon.com and www.flipkart.com.

10.
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B.	 1.	 A blog or weblog is an informational website that often contains information on a particular 
subject. Podcasts and Photologs are types of blogs.

	 2.	 The process of making digital recordings (audio or video) that are available for downloading 
is called podcasting.

		  Podcasting services are https://itsamonkey.com/ and http://revisionisthistory.com.

	 3.	 E-commerce has several advantages. Some of them are:
	 (i)	 It allows us to choose a product from a broad range of products.
	 (ii)	 It saves our money and time.
	 (iii)	 It allows us to sell or buy products and services at any time.

Crack CodeThe

A.	 1.	 www.blogger.com

	 2.	 Google drive.
B.	
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Do yourself

Worksheet–2
(Based on chapters 6 & 10)

A.	 1.	 Backdrop is a background of the stage
	 2.	 Sprite is an object that we see on the scratch stage.
	 3.	 Stage is the main working area to draw or perform action. It shows the output of the 

program.
	 4.	 Scripts area is the area where we pick and drop the blocks from the Blocks Palette to create 

a script/program.
	 5.	 Green Flag is used to run a scratch program.
B.	 1.	 Adobe Dreamweaver		  Amaya

	 2.	 <BR>				    <HR>

	 3.	 Communication			   E-Banking

	 4.	 Net Banking				    E-Wallet

C.	 1.	 Pen

	 2.	 Stamp

	 3.	 Web browser

	 4.	 Container Tag	

	 5.	 Attribute

	 6.	 Newsgroup

	 7.	 Cloud Computing

	 8.	 Spam

D.	 1.	 Hyper Text Markup Language

	 2.	 Standard Generalized Markup Language

	 3.	 Asynchronous Transfer Mode

	 4.	 One Time Password

	 5.	 Common Business Oriented Language
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Test Sheet–2
(Based on chapters 6 to 10)

Section A
A.	 1.	 a.	 2.	 c.	 3.	 c.	 4.	 d.
	 5.	 d.	 6.	 d.	 7.	 a.	 8.	 b.
B.	 1.	 F	 2.	 T	 3.	 F	 4.	 T	 5.	 F
C.	 1.	 Sound	 2.	 body	 3.	 e-greeting	 4.	 Outbox	 5.	 google

Section B
A.	 1.	 Repeat Block is used to draw a Pentagon.

	 2.	 Empty tags contain only opening tag. They do not have closing tag.

	 3.	 In place of </h4>, </h1> should be used.

	 4.	 Hacking is the practice of modifying computer hardware and software to accomplish a goal 
outside of the creator’s original purpose.

	 5.	 Compose button on Gmail is used to create and type a new mail.

	 6.	 The meaning of F9 acronym in an e-mail is Fine.

B.	 1.	 Blocks are puzzle piece shapes that are used to give instructions to the computer.

	 Four pen blocks are:

	 a.	 Pen up

	 b.	 Pen down

	 c.	 Stamp
	 d.	 Set pen color to

	 2.	 The <Body> tag tells the web browser that the text contained between <Body> and  
</Body> tags is to be shown on the web page. It is container tag. Two attributes are:

	 1.	 BGCOLOR 
	 2.	 TEXT
	 3.	 <html>
	 <head> </head>
	 <body>
	 Chemical formula for Sulphuric acid is H<sub>2</sub>SO<sub>4</sub>.
	 <BR> Maths formula for (A + B) <sup>2</sup> is A<sup>2</sup> + B<sup>2</sup>  

+ 2AB.
	 </body>
	 </html>
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	 4.	 Four Safety Measures while using Internet are:

	 (i)	� Never provide personal information, such as address, phone number, or school name 
or location.

	 (ii)	� Keep your browser’s privacy settings ON.
	 (iii)	� Use the Internet only in the presence of your elders.

	 (iv)	�Do not share passwords (other than your parents or teachers).

	 5.	

	 6.	 The process of buying and selling goods or services online is called e-commerce. The 
e-commerce is also known as electronic commerce.

	 Three Payment modes are:
	 (i)	 Debit or Credit Card
	 (ii)	 Net Banking
	 (iii)	E-Wallet




